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Legal notice

Copyright and trademark information relating to this product release.

Copyright © 2000–2023 RWS Holdings plc. All rights reserved.

This legal notice applies to RWS Holdings plc and its subsidiaries and affiliates. All intellectual
property rights contained herein are the sole and exclusive rights of RWS. All references to
RWS shall mean RWS Holdings plc and its subsidiaries and affiliates details of which can be
obtained upon written request.

All rights reserved. Unless explicitly stated otherwise, all intellectual property rights including
those in copyright in the content of this website and documentation are owned by or
controlled for these purposes by RWS. Except as otherwise expressly permitted hereunder
or in accordance with copyright legislation, the content of this site, and/or the documentation
may not be copied, reproduced, republished, downloaded, posted, broadcast or transmitted
in any way without the express written permission of RWS.

Trados Studio is a registered trademark of RWS. All other trademarks are the property of
their respective owners. The names of other companies and products mentioned herein may
be the trademarks of their respective owners. Unless stated to the contrary, no association
with any other company or product is intended or should be inferred.

This product may include open source or similar third-party software, details of which can
be found by clicking the following link: “Acknowledgments ” on page 57 .

Although RWS takes all reasonable measures to provide accurate and comprehensive
information about the product, this information is provided as-is and all warranties,
conditions or other terms concerning the documentation whether express or implied by
statute, common law or otherwise (including those relating to satisfactory quality and fitness
for purposes) are excluded to the extent permitted by law.

To the maximum extent permitted by law, RWS shall not be liable in contract, tort (including
negligence or breach of statutory duty) or otherwise for any loss, injury, claim liability or
damage of any kind or arising out of, or in connection with, the use or performance of the
Software Documentation even if such losses and/or damages were foreseen, foreseeable or
known, for: (a) loss of, damage to or corruption of data, (b) economic loss, (c) loss of actual
or anticipated profits, (d) loss of business revenue, (e) loss of anticipated savings, (f) loss of
business, (g) loss of opportunity, (h) loss of goodwill, or (i) any indirect, special, incidental or
consequential loss or damage howsoever caused.

All Third Party Software is licensed "as is." RWS makes no warranties, express, implied,
statutory or otherwise with respect to the Third Party Software, and expressly disclaims all
implied warranties of non-infringement, merchantability and fitness for a particular purpose.
In no event will Licensor be liable for any damages, including loss of data, lost profits,
cost of cover or other special, incidental, consequential, direct, actual, general or
indirect damages arising from the use of the Third Party Software or accompanying
materials, however caused and on any theory of liability. This limitation will apply even
if Licensor has been advised of the possibility of such damage. The parties acknowledge
that this is a reasonable allocation of risk.

Information in this documentation, including any URL and other Internet website references,
is subject to change without notice. Without limiting the rights under copyright, no part of
this may be reproduced, stored in or introduced into a retrieval system, or transmitted in any
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form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or
for any purpose, without the express written permission of RWS.
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1

Product overview



Trados Studio is a Computer Aided Translation (CAT) tool and translation memory software
that helps you translate and manage translation projects faster and easier.

Trados Studio offers a complete environment for professional translators to edit and review
projects, use agreed terminology and leverage machine translation results. As a project
manager, you can use Trados Studio to effectively manage all aspects of translation projects.

See the online help for information on using Trados Studio.

Freelancer and Starter versions
The Freelance and Starter versions of Trados Studio cannot run on a domain-based
network. This is the intended behavior for these two versions. If you want to run Trados
Studio on a domain-based network, use the Express, Professional or the Studio
Workgroup version instead.

See the Studio comparison table for more information on the differences between the
Trados Studio editions.

RWS AppStore
Download apps which extend the default functionality of Trados Studio.

Cloud references
In this guide, the term "cloud" covers all product offerings powered by our cloud platform:

• Trados Studio's cloud capabilities (formerly known as Trados Live Essential)

• Trados Team

• Trados Accelerate

• Trados Enterprise

• Trados Terminology

1 Product overview
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2

Changes introduced in Trados
Studio 2022 SR2



This release of Trados Studio comes with important cloud enhancements, file type updates
and bug fixes.

Enhanced Manager view
The Manager view continues to evolve, and it's now equipped to handle single-file projects,
project filtering/sorting and viewing reports. We've also introduced key performance and
usability enhancements for working with GroupShare projects and local projects within this
view.

These new integrations reflect the Manager view's growing alignment with the options
available across the Projects, Files, and Reports view.

With the upcoming support for cloud projects, this new view will consolidate all your essential
project management tools into one intuitive location, inspired by the user interface (UI) of
our cloud platform.

For more information about working with the Manager view, see Working with the Manager
view .

Enhanced cloud integration
Trados Studio 2022 SR2 includes a set of enhancements to improve your productivity when
working with cloud projects. Check the release highlights below and see the full list of
changes in the Trados Studio Cloud Capabilities release notes .

Synchronized terminology verification for cloud
projects

Trados cloud offerings will soon introduce terminology verification in Trados Studio, ensuring
alignment with the settings available in Trados Studio.

This enhancement will enable Trados Studio to recognize Terminology Verification settings
coming from the termbase inside a cloud project's Translation Engine.

The settings will be read-only in Trados Studio and can be further edited from your cloud
account. For more information, check out Terminology Verifier settings topic and keep an
eye on the Trados Studio Cloud Capabilities release notes .

Support for flexible workflow templates

The introduction of flexible workflow templates for cloud projects significantly increases
the flexibility of transitioning between various stages of the translation process.

The new Flexible Workflow template available for Trados Accelerate and Trados Enterprise
offering and most other existing workflow templates now include extra tasks and transitions
that make the translation workflow more adaptable to late-stage adjustments.

2 Changes introduced in Trados Studio 2022 SR2
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To support these changes, Trados Studio now allows you to work with new outcomes for
these tasks. This enables you to transition files back to previous tasks, even after completing
the Final Check task.

Support for cloud resources with multiple source
languages

Studio has expanded in cloud capability to accommodate cloud resources with more than
one than one source language .

When creating new cloud projects, Trados Studio can now handle workflows and pricing
models with multiple source language and provides links to previewing their details in your
browser.

Enhanced accessibility
We're continuing our commitment to accessibility by making the Open Package window
fully responsive to Screen Readers and Voice Control, while also enhancing support for
screen readers across various UI elements in the Projects view.

We've also improved the accessibility of Trados Studio's ribbon. You can now find and run all
the commands available in the ribbon through your Screen Reader.

These enhancements complement the existing capability to create projects using these
accessibility options. Future releases will cover additional functionality.

AppStore updates
RWS and third-party developers are constantly adding new Trados Studio apps to our
AppStore.

To ensure compatibility with Trados Studio 2022 SR2, it is necessary to update your apps if
they use terminology capabilities. For more information, see How to update plugins to Trados
Studio 2022 SR2 and the API release notes .

Smart Review app for intelligent review assistance

We're delivering on our commitment to AI innovation with an important new app that will
soon be available in our App Store. The Trados Copilot - Smart Review app for Trados Studio
is a reviewer companion that rates translations in the Editor view on a scale of 0 to 100.
You can use this score and the explanations provided to decide whether to assess segments
in more detail.

Smart Review uses Azure OpenAI and considers any matching scores in your TMs to generate
tailored translation suggestions and assessments. As you approve translations, this data
contributes to enhancing the Language Model's evaluations over time, ensuring continuous
improvement.

2Changes introduced in Trados Studio 2022 SR2
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This app is currently available in early access and requires an Azure OpenAI subscription.
For more information, check out the Trados Copilot - Smart Review app documentation on
the AppStore wiki .

Glossary support for DeepL MT provider

DeepL Translation Provider app now supports working with glossaries to enforce consistency
of terms or phrases throughout translation results coming from this provider.

In addition to creating glossaries, you can also import/export existing ones which you may
find useful when managing entries between glossary databases & platforms.

For more information about working with the DeepL MT provider app, see the DeepL
Translation Provider page on the RWS Appstore Wiki.

CustomModel support for Microsoft and Google Cloud
MT provider

You can now seamlessly integrate your own custom machine translation models and
fine-tune your translations to match your specific terminology, style, and content
requirements.

For more information see the Google Cloud Translation Provider and the Microsoft
Translator Provider apps.

Trados Studio API changes
This release of Trados Studio improves public APIs for easier, more robust third-party
interactions. We've also refactored the terminology API in Sdl.Terminology.
TerminologyProvider. Core to future-proof terminology integrations. If you are a third-party
developer, make sure to check the API release highlights below and the full list of API
changes in the Trados Studio API release notes .

Added API licensing support for subscriptions

When creating standalone apps, you can now use Project automation API calls that need a
license even if Trados Studio is licensed through a subscription. This expands the list of
supported scenarios where Trados Studio is licensed through a cloud subscription, perpetual
license, or network license.

Updates to Editor API

We've renamed the Match property of type ContentRange on the IFind interface to
MatchRange, and added a new property Match of type System.Text.RegularExpressions.
Match.

2 Changes introduced in Trados Studio 2022 SR2
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Updates to Terminology API

We've updated a series of classes, interfaces and enumerations for the Sdl.Terminology.
TerminologyProvider. Core assembly. Find the full list on the Trados Studio API release notes

File types and core components
changes
This section contains an overview of changes and improvements brought to file types and
core components in this release.

• Trados Studio would sometimes change the IDs of tags in .DOCX footnotes, which caused
errors during verification or target file generation. The issue is now fixed. (CRQ-35262)

• Trados Studio would extract formatted text from SmartArt objects available inside .DOCX
files, even when the Extract Hidden Content option was disabled. This issue has been
resolved. (CRQ-35120)

• When processing .XLSM files with the Data validation option disabled, certain content
without associated data validation fields would not be extracted for translation. The issue
is now fixed. (CRQ-33318)

• Fixed an issue that caused inconsistent results when performing schema validation for
files processed with the XML2 filter . (LCC-16675)

• When importing .SDLXLIFF files into new TMs using Keep most recent translation
unit, Trados Studio would sometimes flag some translation units as invalid. The issue is
now fixed. (CRQ-26084)

• Trados Studio no longer shows an "Object reference" error when generating an initial
preview for XML-2.0 files that contain XSLT previews. (CRQ-35088)

• Fixed "Stack empty" error that occurred when opening .XML files. (CRQ-35052)

2Changes introduced in Trados Studio 2022 SR2
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2 Changes introduced in Trados Studio 2022 SR2
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3

Changes introduced in Trados
Studio 2022 SR1



This release modernizes the text editor and enhances cloud compatibility, terminology,
accessibility and security.

Modern technology for the best editing
experience
Continuing the technology modernization started in the previous release, Trados Studio
2022 SR1 further updates the infrastructure behind the text editor for higher visual clarity,
better performance and improved robustness.

This makes the editor capable of displaying sharper, crisper text, and able to handle fonts
much more robustly. The technology update ripples out to better handling of special
characters, better Asian and bi-directional text editing, and faster processing of large
documents.

GroupShare server project
enhancements
With this release, we're continuing to expand the features available for GroupShare server
projects.

Support for GroupShare projects from the Manager
view

You can now open, publish/unpublish GroupShare projects, and performmany more familiar
actions straight from the centralized and intuitive workspace that the Manager view
provides.

Along with this change, we're also adding the File Details section to the Project Details
tab. The File Details section will include useful information about the file you're currently
viewing, such as its path, progress percentage, due date, and more.

To learn more about the Manager view and how to use it to its full potential, see Working
with the Manager view in the online help.

Enhanced security feature for GroupShare server
configuration

Trados Studio now detects if the server added to the <Add Groupshare Server> dialog box
is a secure server, and automatically enables the <This server requires a secure connection
(SSL)> checkbox.

In addition, the <Port> field is automatically populated with the default HTTPS value.

3 Changes introduced in Trados Studio 2022 SR1
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Progress bar in Files view: measure
completion by words or segments
You can now choose to base the progress bar on words or segments in the Files view​.
Depending on the type of document you're working with, you may want to follow your
progress toward completion by checking remaining words or remaining segments in the
file.

By default, Trados Studio shows progress by segments. To change this, right-click on any
column heading in the Files view and choose Confirmation > Progress (Words).

You can switch between Progress (Segments) and Progress (Words), keep them both or
none.

Enhanced terminology verification
With this release, we have enhanced the terminology recognition used for term verification.
The errors displayed in the Editor view > Messages window are now more accurate with
fewer "false positives" being reported.

Since the terminology recognition used for verification is based on fuzzy matching, there is
now a slight chance that the term check is more permissive than before.

While we are perfecting this new behaviour, we are keen to get your feedback around this
change via the Trados Studio user community.

Performance enhancements for batch
processing with large TMs
You can now control Trados Studio's performance when batch processing project files.

The new Optimized Performance option on the Batch Processing page improves the
overall performance of the Analyze Files and Pre-Translate Files batch processing tasks,
especially when working with multiple Trados GroupShare TMs and server project files that
contain a large number of segments.

When running in optimized mode, Trados Studio:

• Ignores any current search settings and uses the settings in the optimized mode

• No longer performs Fragment Recall and Match Repair

• Limits the maximum number of hits found in the TM to the value defined by the
MaxSearchResultsForBatchTasks setting in the Studio configuration file. To configure
this value, edit Studio's config file: C:\Program Files (x86)\Trados\Trados Studio

\Studio17\SDLTradosStudio.exe.config by default.

3Changes introduced in Trados Studio 2022 SR1
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Cloud projects enhancements
Cloud projects benefit from constant updates delivered in our cloud platform. Check the
release highlights below and the full list of changes in the Trados Studio Cloud Capabilities
release notes.

Custom outcomes for user-defined tasks

The Trados Enterprise cloud offering has recently introduced the option to specify custom
outcomes for user-defined transitions in custom workflows.

To support this enhancement, Trados Studio has extended its cloud capabilities to enable
you to work with such transitions from the Studio user interface as well.

When completing a task for which custom outcomes are available, you can now specify a
relevant outcome and leave a comment. Comments are mandatory for tasks that are marked
as Rejected.

For more information about working with such tasks, see the Translating and reviewing
cloud files topic in the online help.

Support for QA-checking inconsistent translations in
cloud projects

Trados cloud offerings have recently updated the QA Checker in the Online Editor to align
its settings for inconsistent translations with those available in Trados Studio.

This means that you can now check for inconsistent translations in cloud projects, in the
same way you can do this for local projects. For more information, see the Specifying
inconsistencies for QA Checker topic in the online help.

Accessibility support for creating
projects
As part of our commitment to provide an inclusive and accessible translation environment
for all users, we started collaborating with our community users to increase accessibility in
Trados Studio.

With their insight, we have added the first vision accessibility functionalities, to enable users
with low vision to interact with the Create New Project Wizard using:

• Screen reader - to read all controls on the wizard

• Voice control - to fill in all the required fields

We will continue making Studio more accessibile in future updates across other areas.

3 Changes introduced in Trados Studio 2022 SR1
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New setting to tweak MatchRepair
scenarios
Trados Studio now checks the segment length before attempting to repair matches during
translation. To display TM results faster, segments over ten words are no longer repaired
automatically.

You can always configure the default value for MatchRepair by editing the
MatchRepairSegmentNumberMax value in the SDLTradosStudio. exe.config file available in
your installation location of Trados Studio.

Other enhancements
This topic lists additional enhancements introduced with Trados Studio 2022 SR1.

• The shortcut for the Browse button from New Project wizard has changed from ALT+B

to ALT+O and it opens the Open Project or Project Template wizard from where you
can select a project template for the new project. (CRQ-30691)

• Trados Studio now supports modern comments from Office 365 and no longer displays
errors when previewing or generating target translations for .PPTX files. (CRQ-31878)

• Trados Studio is now using the latest version of SharpZipLib 1.3.3. (CRQ-31820)

• Trados Studio has seen a number of security fixes to address known vulnerabilities.

Trados Studio API changes
This release of Trados Studio improves public APIs for easier, more robust third-party
interactions. If you are a third-party developer, make sure to check the API release highlights
below and the full list of API changes in the Trados Studio API release notes .

New REST API endpoints for GroupShare projects

With the Trados GroupShare 2020 SR1 CU9 release, all API endpoints have been updated
from the legacy WCF (Windows Communication Foundation) to the REST protocol.

When using Trados Studio 2022 SR1 with this Trados GroupShare release, all communication
is performed via the new REST API endpoints. When using Trados Studio 2022 SR1 with
older Trados GroupShare versions, the communication will continue to be performed using
WCF. You can check the list of new endpoints in the Cumulative Updates for Trados
GroupShare 2020 SR1 article .

3Changes introduced in Trados Studio 2022 SR1
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Assemblies retargeted to .NET Standard

Some of the available APIs have been retargeted from .NET Framework 4.8 to .NET Standard
for better compatibility options and richer overall support.

Access to Studio's custom language registry

You can now access Trados Studio's custom language registry, which offers finer control
over language management than the language registry provided by Microsoft.

General API changes

Plugins designed for earlier versions of Trados Studio might not work with Trados Studio
2022 SR1 due to several updates to the API and infrastructure in this release. The addition
of the 'RequiredProduct' setting in the Plugin Manifest now allows the RWS AppStore to
accurately identify plugins that are compatible with this Trados Studio version. For further
details, refer to the 'How to update plugins ' section in the API documentation.

Changes for third-party App developers

To maintain app's compatibility with Trados Studio 2022 SR1 following the way language
metadata is handled, make sure to:

• update the RequiredProduct details within thepluginpackage. manifest.xml file to mirror
the latest software version.

• check that any code referencing theSdl.Core.Globalization. Language now references
Sdl.Core.Globalization.Async instead.

• consider the shift to using the custom language registry provided by Trados Studio
rather than Microsoft's registry.

AppStore improvements and new apps
RWS and third-party developers are constantly adding new Trados Studio apps to the RWS
AppStore. To find the newest apps, sort by Newly added in the integrated AppStore or
use the Product version filter on the website version of the AppStore .

OpenAI Translator plugin for ChatGPT

An important recent addition to the AppStore is the OpenAi Translator plugin. This uses
artificial intelligence to generate alternative translations and provides additional information
about the source/target content in the Editor view. You can create custom prompts or use
the five default prompts to guide the AI.

For instructions on using the app, see the OpenAI Translator wiki .
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File types and core components
changes
This section contains an overview of changes and improvements brought to file types and
core components in this release.

General improvements

• To enhance security, we've updated all components to the latest version of SharpZipLib.
(LCC-14655)

• Updated all components to the latest version of Newtonsoft.JSON. (LCC-14693)

• Updated all components to use StableCultureInfo instead of CultureInfo. (LCC-14486)

• Trados Studio would add an empty segment after segments that ended in a placeholder.
This issue is now fixed. (LCC-14303)

• Fixed an issue where unicode "TIBETAN MARK INTERSYLLABIC TSHEG" character
would not be recognized as a word delimiter. (CRQ-15202)

• Solved an issue with Trados Studio that caused it to crash when importing .PDF or .DOCX
files containing a lot of spaces. (CRQ-5757)

• Fixed "The TM May contain Invalid Translation Units" error that occurred when searching
translation memories with field name IDs. (CRQ-26275)

DLL

• Added support for .NET 6 libraries. (LF-5739)

Markdown

• Added support for the Admonition extension. (LCC-13464)

• Trados Studio failed to generate target files if the translation contained tags that were
not available in the source file. This issue is now fixed. (CRQ-31713)

• Translated table of contents would sometimes not show up in the target file. This issue
is now fixed. (CRQ-31830)

XML2

• Cancelling formatting changes in embedded XML content would sometimes still save
the modifications. This issue is now fixed. (LCC-14689)

• Stopped reporting warning about unsupported value for xml:lang. (LCC-14170)

• Verifier dependency files are now correctly cleaned up once the file processing is
completed. (LCC-14142)

• Fixed an issue that prevented opening links in the XLST preview. (CRQ-28804)

• Fixed an issue that would change formatting settings when using an XML2 filter with
Embedded content processing. (CRQ-31002)
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• Files without explicit encoding declaration would be incorrectly detected as US-ASCII.
This issue is now fixed. (CRQ-31079)

• TMX files exported from DeepL could not be imported into Trados Studio TMs. This
issue is now fixed. (CRQ-31197)

CSV

• Fixed an issue that prevented the HTML side-by-side preview for .CSV files. (LCC-14631)

XLSX

• Fixed an issue with table column lines disappearing when converting specific files to
HTML. (LCC-14428)

• Added the ability to extract legend text and plotted data from an Excel chart. (CRQ-10338)

• Fixed an issue that prevented series names from being extracted for translation.
(CRQ-28426)

• Colored headers & footers were included in translation even when the the option to
Skip cells having the selected text color was enabled. (CRQ-28342)

• The Editor would display line breaks from the Data Validation Input Message. This issue
is now fixed. (CRQ-30962)

• Fixed''Could not find a part of the path' error that was sometimes displayed when
generating target files. (CRQ-30555)

DOCX

• Fixed ''Sequence contains no matching element'' issue that sometimes occurred when
generating the target file. (CRQ-31620)

• The Apply Track Changes before opening setting would not work for track change
related to formatting. This issue is now fixed. (CRQ-29031)

• Fixed an issue where links inside footnotes would not be extracted for translation.
(CRQ-32593)

• Fixed 'The process cannot access the file 'C:\x' because it is being used by another process'
error message that was sometimes displayed when generating the target file.
(CRQ-32438)

IDML

• Trados Studio now extracts fields descriptions for translation. (CRQ-28573)

• Added support for .IDML files saved with InDesign 2023 (18.0). (CRQ-31595)

• Fixed an issue where grouped hidden text was extracted for translation ignoring current
settings. (CRQ-31303)

• Fixed ''Start tag on line does not match the end tag'' error that occured when generating
the target file. (CRQ-31635)
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PPTX

• Fixed error that occurred when preview or generating target .PPTX files with modern
comments. (CRQ-31878)

XLSM

• In specific scenarios, Trados Studio would generate corrupt target file that could not be
opened it in Microsoft Excel. This issue is now fixed. (CRQ-31836)

MS Visio

• For specific files, Trados Studio would generate empty translations. This issue is now
fixed. (CRQ-31410)

Bilingual Excel

• Trados Studio would generate corrupted translations for source text that used font size
with decimal points. (CRQ-31380)

XLIFF

• Added BOM detection in both XLIFF 1.2 and XLIFF 2.0. BOM is not added to target file if
not present in source file. (CRQ-27734)

• Fixed an issue that occurred when Windows was set to a region that does not use full
stops as a decimal points, which causedMatchQuality to exceed the standard range of
0 - 100. (CRQ-28432)

• Content between formatting tags would not be exported in the target file when the
.XLIFF files was Perfect Matched with a file type that supports formatting. This issue is
now fixed. (CRQ-28496)

• Trados Studio would create invalid elements in the target .MXLIFF file, which corrupted
the file. This issue is now fixed. (CRQ-30803)
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4

Changes introduced in Trados
Studio 2022



This release of Trados Studio comes with cloud enhancements, new file types, core
components updates as well as bug fixes.

Enhanced cloud experience

Refined save to cloud functionality

We refined the Save local projects to cloud functionality to offer support for project
templates.

When moving local projects to cloud, you now have the option to save a project to cloud
based on a project template previously configured in your cloud account.

This gives you much finer control over how the project is processed and simplifies working
or sharing with your team.

Migrate termbases to cloud

This release expands on the cloud portfolio with more options.

In addition to projects and translation memories, you now have the option of migrating
your local termbases to cloud. This is done through a quick and easy wizard which gives you
full control over your files and how they will be imported.

For more information see Migrate local termbases to cloud in the online help.

Built-in cloud capabilities

If you are an individual Trados Studio user you can get started working in the cloud right
away! The cloud subscription formerly known as Trados Live Essential is now an integral part
of your product license.

The now built in cloud capabilities provide access to your own secure cloud space, for free!
With the cloud and Trados Studio you can work from anywhere, anytime and blend
seamlessly between the two.

Enhanced cloud integration

Introducing real-time cloud projects refresh and notifications in Trados Studio.

This year's release introduces SignalR technology for real-time client-server communication.
SignalR allows the server to send asynchronous notifications to clients, as they happen.

This means that Trados Studio presents the most up-to-date cloud information without
needing to hit the refresh button. SignalR also offers better performance when interacting
with cloud projects in Trados Studio as well as more fluid project flows and taskmanagement.
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Software localization for Microsoft .Net
libraries
Starting with the 2022 release, Trados Studio comes with software localization capabilites.

The new file formats enable you to localize Microsoft .NET binary files such as WPF and
Winforms, as well as multilingual Excel files used in gaming and other industries.

The multilingual Excel file type is provided through an app that is launched along side Trados
Studio 2022 via the AppStore.

Better and more stable font handling
The text editor in Trados Studio 2022 is now more modern and offers improved functionality.

We updated the underlying infrastructure from the old Graphics Drawing Interface (GDI) to
the more modern and stable graphics API, Direct2D.

Direct2D can draw to the screen using the Graphics Processing Unit (GPU). This provides
several benefits:

• Font rendering is sharper, more legible with smooth edges (anti-aliasing).

• Can render any character in the Unicode range.

• Support for special or custom fonts is present.

• Rendering is faster, as it happens on the GPU.

• Leaves room for other graphics APIs in the future.

New Manager View (Beta)
This release innovates on Trados Studio's user experience with the next generationManager
View.

While still in its early beta stage, theManager View is meant to offer you a centralized and
intuitive workspace, packed with features and functionality that make your work easier and
more effective.

How does theManager View improve efficiency?

• You can easily browse through your projects using a single integrated view.

• You can navigate through project files in a centralized and organized way.

• You can inspect translation statistics and reports at the click of a button.

• You can keep track of your data using color coded graphs, and much more.

You can enable or disable theManager View at any time from the ribbon, as well as leave
feedback in the left-most panel of the window.
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To learn more about theManager View and how to work with it see Working with the
Manager view in the online help.

Decomission of XML V1
The XML 2 file type is now the default and only file type for XML documents.

The legacy XML1 file types are still available as hidden files type behind the scenes so that
projects using that file type can be completed without issues. For new projects, only the latest
XML 2 file type can be used.

If you have XML1 file type settings that you want to transfer to the XML 2 file type, see
Migrating XML V1 file type settings to XML V2 .

Compatibility updates for Microsoft
products
The updates brought to Trados Studio 2022 offer full support for Microsoft Office LTSC 2021
as well as Microsoft Windows Server 2022.

Trados Studio 2022 offers full, out-of-the-box support for both Microsoft 365 as well as
Microsoft Office LTSC. Microsoft Office LTSC is the latest perpetual version of Microsoft Office.

Trados Studio can process this version of Office files even if you do not have Office installed.
You may want to install Office to:

• preview translated MS Office files in their native format

• use the Word spell-checker in the Editor instead of the default Hunspell that is installed
with Studio.

Starting with this release you can also deploy Trados Studio on Microsoft Windows Server
2022 and take advantage of the operating system's new features and functionality.

File types and core components
changes
This section contains an overview of changes and improvements brought to file types and
core components in this release.
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Real-time preview

The new real-time preview technology included in this release allows you to preview your
files as you are translating them.

This new technology also helped fix a number of related issues, such as the cursor
disappearing or unexpected behaviour.

Removed support for XML 1 file types

The XML 2 file type is now the default and only file type for XML documents.

The legacy XML1 file types are still available as hidden file types behind the scenes so that
projects using that file type can be completed without issues. For new projects, only the latest
XML 2 file type can be used.

If you have XML1 file type settings that you want to transfer to the XML 2 file type, see
Migrating XML V1 file type settings to XML V2 .

InDesign 2022 support

This release brings full support for Adobe InDesign 2022 file types.

General improvements

• Added new .Net file filter.

• Improved overall file processing performance.

• Updated OpenXML package to the latest version. V2.15.0.

Fixed issues

• Fixed an issue that generated incorrect Context Matches when importing an *.SDLXLIFF
document to a file-based TM. (LCC-12792)

Excel

• Fixed an issue that prevented Studio from generating the target files if the source file
had the same values in different columns on the first row and theHeader row option was
unchecked. (LF-5728)

XML

• Fixed an issue that caused "File processing error: ']]>' is not allowed in character data."
(LF-5743)
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XML V2

• Fixed an issue that prevented Studio from opening files if special tags were set as Inline
instead of Structure. (CRQ-27591)

HTML

• Fixed an issue that caused incorrect structure in the target file if the source document
contained attribute values not enclosed in quotes. (CRQ-27221)

Photoshop

• Updated the Aspose.PSD dependency which fixed a number of related issues:

• "One or more files not supported" error. (CRQ-22702)

• Invalid file error when opening certain PSD files (CRQ-23975)

• Incorrect text spacing in target file. (LF-5297)
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5

Resolved issues



Trados Studio 2022 SR2 contains all previous cumulative updates for Trados Studio.

Issues resolved in Trados Studio 2022
SR2
This list details the issues that were resolved in the Trados Studio 2022 SR2 release:

• TheMy Account link on the Cloud Sign window now correctly points you to the relevant
page for your subscription you have.

• Trados Studio now correctly applies the selected input model when working with the
Default layout in the Termbase Viewer. (CRQ-33002)

• Accessing the forums from within Trados Studio under Help> Forums now correctly
displays forum content inside the RWS Community Inside window.

• Fixed "Unable to save local project to cloud" error that sometimes occurred when trying
to save projects that use custom settings for the Multilingual XML, Multilingual Excel, and
.TTX filetypes. (CRQ-33834)

• Fixed issue that enabled members of user groups without Open in Studio permisssions
to download cloud projects visible for their account. This issue is now fixed. (LG-39978)

• When migrating TMX translation memories to the cloud the Created by, Last Modified
by, Last Used by translation units system fields would incorrectly be replaced with
the username of person who uploaded the TM to the cloud. (CRQ-31150)

• Fixed "You do not have access or have insufficient permissions" error that would sometimes
occur when trying to remove connected devices from a cloud account. (CRQ-35537)

• Fixed "Object reference not set to an instance of an object" error message that occurred
when opening .DOCX files containing SmartArt objects. (CRQ-34235)

• The Project Details, Confirmation Statistics, and Task History windows in the Projects
view are now correctly narrated by their name. (CRQ-33462, CRQ-33463)

• Hovering over tags now displays their content correctly. (CRQ-35723)

• Users with External Translator role were unable to view cloud projects assigned to them
when the ViewOther Users Projectswas disabled. This issue is now fixed. (CRQ-33353)

• Trados Studio would incorrectly apply translations coming from DeepL or Amazon MT
providers inside Translation Engines. (CRQ-35682)

• Improved documentation to clarify how Studio displays the translation memories and
termabses used in a cloud projects when comparing the online and offline way of
working with cloud projects.
Cloud translation packages manually uploaded to Studio always list the individual TMs
and termbases inside the translation engine. Conversely, projects opened from the cloud
using theOpen in Studio option only show the name of the translation engine available
for the project.

To check the termbases and translation memories inside a translation engine, open
your cloud account in a browser and check the resources attached to the translation
engine from the Resources tab.

• The Trados Compatibility and Migration Power Pack app would sometimes fail to
upgrade .TMW translation memories. This issue is now fixed. (CRQ-35774)

5 Resolved issues

26 Release Notes



• Fixed an issue with API calls for Pretranslate and Word Count batch tasks failing
randomly. (CRQ-30444)

Issues resolved in Trados Studio 2022
SR1
This list details the issues that were resolved in the Trados Studio 2022 SR1 release:

• Fixed an issue that caused an object reference error when trying to create a new
translation memory (TM) through the Create a new project wizard. (LG-37361)

• Trados Studio no longer automatically terminates SSO connections to GroupShare 2020
SR1 CU7 servers after one hour of inactivity. (CRQ-31278)

• Solved an issue with Replace All that prevented changes from being made in the Editor
without clicking Find Next first. (CRQ-19797)

• Confirming segments while working with a server-based TM no longer displays the
"Generating preview" message in the status bar. (CRQ-24385)

• Opening a GroupShare project file that was already checked out by a different user
triggered a File Check In while the translation is in progress. This issue is now fixed.
(CRQ-32565)

• Fixed an issue that occurred when trying to open a cloud project using a different account
than the one currently used in the browser. (CRQ-32077)

• When completing the cloud project task without first saving the changes, Trados Studio
would sometimes upload an earlier version of the file to the cloud. This issue is now
fixed. (CRQ-32466)

• When using Trados Studio on a Finnish OS, changes to cloud project files would not be
uploaded to the cloud. This usually happened when completing a task and moving the
file to the next translation stage. This issue is now fixed. (CRQ-26179)

• Fixed an issue where changes to large cloud project files were sometimes not uploaded
to the server. (CRQ-25341)

• Trados Studio would not remember the selected layout in the Termbase Viewer after
closing the application. The issue is now fixed. (CRQ-13726)

• Fixed an issue where machine translation resources added under the translation engine
at project level would also get updated in the main translation engine. (CRQ-32016)

• In very specific scenarios, recreating a TM during project creation failed if the first
instance TM was deleted while Trados Studio was still running. This affected how
document segmentation was applied through TMs. The issue was fixed by clearing
memory cache of the previous TM when deleting it. (CRQ-25266)

• We improved the error message displayed when reaching the maximum capacity of
registered devices per subscription. (CRQ-30844)

• Trados Studio incorrectly created an invalid element in target .MXLIFF files which
corrupted them. The issue is now fixed. (CRQ-30803)

• Fixed an issue where, in certain scenarios, cloud projects were showing incorrect
progress percentages in the status bar after finishing the translation. (CRQ- 29237)

• Fixed an issue where the status of a file in Trados Studio reverted from Translation
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Approved to Translated after completing the review. (CRQ-28660)

• When searching for terms in the source segments using the CTRL+F shortcut, Trados
Studio would always displayed the first results from the beginning of the document,
regardless of the location of the currently selected segment. The issue is now fixed.
(CRQ-18873)

• Trados Studio would duplicate the phase assignments for projects based on project
templates with inconsistent language codes (de-de; de-DE). This issue is now fixed.
(CRQ-30922)

• Trados Studio could not open .PDF/.DOCX files that contained many whitespace
characters. This issue is now fixed. (CRQ-5757)

• Mismatched tags are now correctly reported accordingly when the Check forTag ID
mismatch option is enabled. (CRQ-30505)

• Exporting .TMX files using TMExporter plugin in Trados Studio, generated empty files.
The issue is now fixed. (CRQ-32022)

• For server-based TMs, the Pre-Translate batch task would not apply available context
matches on translation units with existing content in the target segment. (CRQ-31167)

• Translated segments were missing after generating the target for specific Markdown
files. The issue is now fixed. (CRQ-31830)

• Fixed an issue where Trados Studio used the rejected segments when running Analyze
Files, leading to incorrect results displayed in reports. (CRQ-31871)

• Migrating local translations usingMigrate Local TMs to Cloud option failed with an
'Unable to migrate local TMs to cloud' error message displayed inNotifications dialog box
when adding file-based TMs. The issue is now fixed. (CRQ-32450)

• Fixed an issue where segments that contained rejected tracked changes and did not
have an 100%match in the TM were not counted in the Analyze Files report. (CRQ-31910)

• Fixed an issue where Trados Studio stopped working when adding formatting on locked
segments. (CRQ-22153)

• In certain scenarios, Trados Studio couldn't recognize specific custom font from source
documents. The issue is now fixed. (CRQ-18695)

• Fixed an issue where Trados Studio displayed corrupted Malay characters in the Editor
view. (CRQ-22484)

• Trados Studio would not remember the selected input model in the Termbase Viewer
after closing the application. The issue is now fixed. (CRQ-33001)

• Activating Trados Studio with a cloud subscription failed with an 'Can't reach this page"
and 'Navigation to the webpage was canceled" errors if TLS 1.3 was installed. The issue is
now fixed. (CRQ-31716)

• Addressed a situation where Trados Studio would specify the wrong cloud account
when opening cloud project files, which resulted in an 'Error processing command line
arguments: Cannot connect to the cloud'' error message. (CRQ-32106)

• Fixed a small issue in the Files View > Home > Layout group, where the <New Layout>
option in the drop-down menu wasn't displaying the angled brackets correctly.
(LG-36696)

• Fixed an issue in the New Project Wizard that prevented you from adding .SDLXLIFF
files after removing the default target language. (LG-35935)

• Fixed the 'Key not present in a dictionary'' error displayed when trying to open a cloud
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task that set to Complete. Trados Studio will now correctly display a 'No tasks available'
message instead. (LG-31192)

• Solved a problem with the Notifications section still receiving updates when signing
out of your cloud account in Trados Studio. (LG-37264)

• Fixed an issue that occurred when logging into multiple GroupShare accounts with
different authentication methods. Trados Studio now recognizes the correct user when
working with server projects. (LG-37549)

• Addressed an interaction issue between Trados Studio and GroupShare that prevented
files newly added through the Studio API from being checked in to GroupShare.
(CRQ-32184)

• In certain scenarios, adding termbases from a Trados GroupShare server to a local
project in Trados Studio, would fail with an 'Could not connect to the 'TermbaseName'
termbase, so you cannot use it for term recognition.' error message. The issue is now fixed.
(CRQ-29352)

• Importing partially translated .SDLXLIFF files into server-based TMs sometimes failed
with multiple errors. The issue is now fixed. (CRQ-32295)

• Fixed an issue where saving projects to cloud would fail on the French UI when the
Windows Regional format was set to English (United Kingdom). (CRQ-33750)

• Using the TAB button on New Project Wizard would not focus controls in a logical
order. Similarly, tabbing through the buttons on the Add/Edit GroupShare Server dialogs
would not select buttons from left to right, as expected. These issues are now fixed.
(CRQ-30692, CRQ-30829)

• Opening a file for review with an associated TQA Model in Trados Enterprise would not
transfer the TQA model to Studio through the project settings. The issue is now fixed.
(CRQ-31141)

• Bangla characters are now correctly displayed in the Editor view. (CRQ-27353)

• We've improved the text contrast for the buttons on the right side of the Editor view.
(CRQ-30696)

• In specific files, the Terminology Verifier would display false warnings across many
languages. This issue is now fixed. (CRQ-8035)

• Activating Trados Studio on a Turkish OS would fail when using a subscription license.
The issue is now fixed. (CRQ-27456)

• Private Use Area characters in source text would not displayed correctly in the Editor
view. The issue is now fixed. (CRQ-31109)

• Trados Studio would redirect to an incorrect webpage when accessing context-sensitive
help from a UI language for which localized documentation is not available. This issue
was fixed and Trados Studio now correctly redirects to the default English version of the
documentation instead. (CRQ-32347)

• Adjusted the way Trados Studio handles translation memory imports. Previously this
would result in units not being imported from their respective TMs. This has now been
fixed. (CRQ-33502, CRQ-34017, CRQ-32352)

• Fixed an issue that prevented Trados Studio from displaying non-breaking spaces when
the UI language was set to English while running on a Chinese OS. (CRQ-27674)
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Issues resolved in Trados Studio 2022
This list details the issues that were resolved in the Trados Studio 2022 release.

• When trying to save project files, Trados Studio would display "Could not find part of the
path:" error. This was caused by a missing path in the Temp folder. The issue is now
fixed. (CRQ-27978)

• Fixed an issue with files not being updated from Trados Studio to Trados cloud offerings
if they were in Linguistic Review. (CRQ-25381)

• Trados cloud offerings would display an ErrorCodeBadRequest when trying to open a
project with a big number of files. The issue is now fixed. (CRQ-27526)

• Terminology Verification task would fail if the termbase contained duplicate synonyms,
displaying the following error: "Failed to verify document: Sequence contains more
than one matching element." The issue is now fixed. (CRQ-16718, CRQ-6478)

• Fixed an issue that caused Trados Studio to display Snihala characters incorrectly.
(CRQ-23504)

• Fixed an issue that caused Trados Studio to crash when opening IDML or PPTX files with
long font names. (CRQ-23865, CRQ-27587, CRQ-27585, CRQ-27515)

• Fixed an issue that cleared the Project Filters in the Projects view when restarting
Trados Studio. (CRQ-23550)

• LC Project pushed to GroupShare via Helix couldn't be opened in Studio when target
language is Japanese. The issue is now fixed. (CRQ-23543)

• Fixed an issue where Trados Studio would sometimes not properly refresh the Projects
list when signed out of your cloud account. (CRQ-26813)

• Fixed an issue that caused the PerfectMatch batch task to fail for users that activated
Trados Studio using a Trados Studio Professional subscription rather than perpetual
license. (CRQ-28170)

• When clicking the Open in Studio button, Trados Studio would list the project as an
Offline Cloud Project instead of Cloud Project. The issue also prevented Trados Studio
from synchronizing any changes. The issue is now fixed. (CRQ-27129)

• Fixed an issue that caused Trados Studio to crash when opening files. This crash was
caused by source text that had a font applied to it which contained special characters in
the name, for example comma (,) or quote ("). (CRQ-24497)

• Fixed an issue where Trados Studio would display 'No internet connection' notification
incorrectly. (CRQ-21946)

• Fixed an issue with Terminology Verifier where Trados Studio wouldn't display a
warning message in if a target term was missing and repeating. (CRQ-17208)

• Fixed an issue where the date and time format from a TM entry would be converted
inconsistently into the target segment, sometimes with invalid values. (CRQ-25970)

• Fixed an issue that caused the Hitlist settings from the Termbase Recognition window
to disappear when using Language Cloud Terminology and switching between
segments. (CRQ-18393)

• Fixed an issue that occurred on projects published on GroupShare that included
file-based termbases. The issue caused the Terminology Verifier to fail when veryifing
the document. This issue is now fixed. (CRQ-6478)
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• Creating a GroupShare TM from Studio without specifying a Language Processing
Rules Template in the New Server-based TM wizard would cause the creation process
to fail. This issue occurred for accounts that are part of multiple organizations and is
now fixed. (CRQ-27652)

• Fixed an issue that caused the cursor to disappear after clicking into the Preview
window. (CRQ-6669)

• Fixed an issue that occurred when Pre-Translating/Analyzing Files during project
creation for project templates that used cloud machine translation in certain flows.
(CRQ-24339)

• When copying results from the Concordance Search panel the cursor was duplicated
and copying was not possible anymore. The issue is now fixed. (CRQ-20787)

• Fixed font adaptions not being properly applied in the Alignment Editor. (CRQ-5764)

• Fixed an issue that occurred in the Open Trados GroupShare Project dialog box. The
issue caused the Status dropdown list to display "No results" when attempting to filter
projects. The issue is now fixed. (CRQ-27095)

• Fixed an issue that caused Term Recognition Hitlist Settings to not be saved after
closing Trados Studio. (CRQ-28118)

• Fixed an issue that caused project package creation to fail when trying to create a project
package based on an offline cloud package that contained file references. (CRQ-25034)

• Fixed an issue that occurred when trying to create a new cloud project from Trados
Studio. Cloud project creation failed with error message: "There was an error when trying
to make a POST REQUEST". This issue is now fixed. (CRQ-23703)

• Fixed an issue that occurred when searching for matches in source segments. The issue
prevented the match highlight from disappearing after shifting the focus to a different
UI element. (CRQ-18445)

• Fixed an issue that caused Trados Studio to crash when applying translation from a
translation memory on a locked segment. (CRQ-11967)

• Downloading a project package from the cloud resulted in the message "Your download
may take some time. You will receive a notification when it is completed." without the
download ever completing. This issue is now fixed. (CRQ-28168, CRQ-2804, CRQ-27881)

• Fixed an issue where the workflow dropdown would not display any workflows when
saving a local projects to cloud. (CRQ-28165, CRQ-25502)

• Fixed an issue in the Trados Studio API where the SetActiveSegmentPair did not work
as expected for files with embedded content. (CRQ-27834)

• Fixed an issue where "Create WorldServer Return Package" option would be grayed
out after publishing WorldServer project on GroupShare. (CRQ-27598 )

• Fixed an issue that occurred when generating the preview for certain Word documents.
The Preview would crash with error: "File processing error: Cannot remove because
there is no parent." The issue is now fixed. (CRQ-24755 )

• Fixed an issue that caused "Null reference exception" when running the Analyze batch
task after merging two segments. (CRQ-23913)

• Fixed an issue where importing a project template would not finish successfully if the
list of project templates already contains a template with the same GUID. (CRQ-16780)

• Fixed an issue where the Find or Filter function would not detect occurrences if the
occurrences were directly followed by locked segments. (CRQ-15073)
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• Fixed an issue where the Preview button in the Online Editor was not present for projects
published from Trados Studio. (CRQ-27003)
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6

Known issues



This section lists the limitations associated with Trados Studio 2022 SR2.

MultiTerm language codes limitation

The new languages available in MultiTerm work for local termbases only.

Support for the new languages will be added to GroupShare and server-based termbases in
a future GroupShare update as soon as possible.

Local batch tasks do not check cloud translation
engines

By design, it is not possible to use cloud translation engines when running batch tasks on
local projects. Cloud engines are applied during pre-processing cloud projects, so it is
recommended to create cloud projects or save local projects to cloud to enable batch
processing. This means, for instance, that the Analyze Files batch task will not reflect correct
numbers if you run it from Trados Studio. Nor will the Pre-translate batch task apply any
results from cloud-based translation memories, as this already happened in pre-processing.

As best practice, we recommend the following:

• Use the Save to Cloud functionality for local projects. This combines the best of both
worlds: you can prepare the files locally and then move them easily to the cloud for
running batch processing against translation engines and sharing all resources with your
team.

• For any projects that you wish to keep local, use theWIP Report, Translation orWord
Count batch tasks in Trados Studio. These batch tasks can always be run locally and give
you an accurate overview of the work required for your current file or the project as a
whole.

• Use the Bilingual Engineering task available in the Standard Translation & Review
workflow. This task is placed after Translation Memory Matching and Machine
Translation, but before Analysis and enables you to manipulate the bilingual files before
they are analyzed or translated.

Cannot run local batch tasks on remote cloud
files

You can only run batch tasks on cloud files that are downloaded in Trados Studio and
available on your computer. Open cloud files in the Editor view to bring them in Trados
Studio where you can then run batch tasks locally.
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"Reset to default" option in Verification Settings
resetting specified values improperly

Using the Reset to default button under the Verification Settings menu will reset the values
of read-only fields.
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7

Installing Trados Studio



This section contains general information on installing and the technical requirements for
the installation.

For step-by-step instructions on how to install and maintain Trados Studio 2022 SR2, see the
Installation Guide .

Installation requirements

Hardware requirements

• A Microsoft Windows-based PC or an Intel-based Apple Mac computer running Windows
as an operating system

• Up to 2.5 GB of available disk space to run the Trados Studio 2022 SR2 installer

• 2 GB of available disk space to run Trados Studio

• A 32-bit (x86) or 64-bit (x64) processor

• 32-bit (x86) OS

• 1 gigahertz (GHz) or faster processor

• 8 GB RAM

• A screen resolution of 1280x1024 pixels and 256 colors or higher

• 64-bit (x64) OS

• A recent processor with dual or multi-core technology

• 8 GB RAM

• A screen resolution of 1280x1024 pixels and 256 colors or higher

Operating Systems

Supported OS

• Trados Studio 2022 SR2 runs on the latest build of Windows 11, Windows 10 andWindows
8.1.

• Trados Studio also supports Windows Server 2019, Windows Server 2016, Windows
Server 2012 R2. As a general rule, Trados Studio tries to support the operating systems
officially supported by Microsoft.

Limited Windows 7 support

Microsoft has stopped support for Windows 7. As a result, we are no longer testing or
supporting Trados Studio on Windows 7. However, if you intend to remain on Windows 7,
youmay be able to do so successfully for the time being by enabling TLS 1.2 as default secure
protocol . Trados cloud and GroupShare 2017 SR1 and later only accept TLS 1.2 connections
to ensure the highest data security when sharing projects on RWS servers.

Unsupported OS

Trados Studio does not support earlier operating systems such as:
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• Windows 8

• Windows Vista

• Windows XP

• Windows 2003 Server

Recommended OS

RWS recommends that you use Windows 11 or 10 because they are the current and best
supported OS from Microsoft.

Microsoft Office

Trados Studio 2022 SR2 offers full, out-of-the-box support for all Microsoft Office 365,
Microsoft Office 2021, Microsoft Office 2007-2019 and 2000-2003 file formats.

Trados Studio can process these versions of Office files even if you do not have Office
installed on your computer. However, you may want to install Microsoft Word and PowerPoint
to:

• preview translatedWord, Excel and PowerPoint documents in their native format, outside
Trados Studio.

• use the Word spell-checker in the Editor instead of the default Hunspell that is installed
with Trados Studio. For spell-checking, Trados Studio requires Microsoft Office 2021,
2019 or 2016. Older versionsmight also work but are not tested. As a general rule, Trados
Studio supports the latest and previous generation of any third-party product.

Browsers

• The Welcome tab with drag-and-drop capabilities is only available on PCs with Microsoft
Internet Explorer 10 or later.

• On PCs with Microsoft Internet Explorer 9 or earlier, the old Welcome tab content is
displayed.

• The Trados cloud dashboard and Trados Terminology require the latest version of
Microsoft Edge, Google Chrome and Mozilla Firefox to work.

Trados Studio Help

The Trados Studio Help buttons are context-sensitive and redirect to the online deliverable
on the RWS Documentation Center. This means that to get access to the latest updated help
for Trados Studio you need an Internet connection and one of the following Internet
browsers installed:

• Microsoft Edge

• Google Chrome (latest version)

• Mozilla Firefox (latest version)

• Safari 7 and later

• Microsoft Internet Explorer 10 and later
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If you need to consult the full product documentation in a location with no Internet access,
you can download the WebHelp documentation deliverable, a ZIP file containing all the
documentation as static Web pages.

To download the ZIP file, access the following link Trados Studio 2022 SR2 full documentation
as WebHelp deliverable . Unpack this ZIP file in a location of your choosing and open
index.html in an Internet browser.

Please note that the documentation may be subject to change after the product has been
released. The live documentation resource in the Documentation Center is always the most
up-to-date resource.

Installing and upgrading

Trados Studio 2022 SR2 installation

You can download the Trados Studio 2022 SR2 installer from your account .

When installing Trados Studio 2022 SR2, make sure that you have administrator rights and
that no other software is running.

Trados Studio 2022 SR2 installs side-by-side with previous major versions of Trados Studio.

However, as a service release for Trados Studio 2022, Trados Studio 2022 SR2 installs on top of
previous Trados Studioversions and cannot run alongside them.

You can find a full list of the software, including third-party software installed with Trados
Studio in the Trados Studio Installation Guide .
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8

Licensing Trados Studio



For detailed instructions on how to activate permanent and subscription Trados Studio
licenses, see the Licensing Help .

For any licensing or installation issues, contact support here:
https://gateway.sdl.com/liveagentlicensing

Upgrading from Trados Studio 2021

After upgrading from Trados Studio 2021 to Trados Studio 2022, your original license will be
automatically removed from your account.

If you want to use Trados Studio 2022 SR2 side-by-side with Trados Studio 2021, you can use
both on the same machine using the Trados Studio 2022 SR2 license. This is only possible
for single-user licenses.

Upgrading from Trados Studio 2019,
2017 or 2015

After upgrading from Trados Studio 2019, 2017 or 2015 to Trados Studio 2022 SR2, your
original license will be automatically removed from your account. To continue using an older
version, you should consider purchasing a full license instead of an upgrade.

If you want to try Trados Studio 2022 SR2 side-by-side with Trados Studio 2019, 2017 or
2015, you can use the 30-day trial that is available in Trados Studio 2022 SR2.

Licensing Trados Studio 2022 SR2 from
Trados Studio 2022
If you have a Trados Studio 2022 perpetual or subscription license, you can upgrade to
Trados Studio 2022 SR2 for free.

As a service release for Trados Studio 2022, Trados Studio 2022 SR2 shares the same
activation codes and cloud credentials.

Using Trados Studio 2022 SR2 with a
network license

Trados Studio 2022 SR2 uses licensing technology based on SafeNet network licensing. To
activate Trados Studio 2022 SR2 network licenses you need the latest version of Trados
License Manager. At the time of Trados Studio 2022 SR2 release, the latest Trados License
Manager version is version 17.
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Multiple product editions on a license server

In Trados Studio 2022 SR2, you can connect to a network license server that has multiple
product licenses active and choose what Trados Studio edition to use. For more information
on how to connect to a license server, see the Licensing Help .

Remote Desktop connections

When using a Remote Desktop Connection, you can run more than one instance of Trados
Studio on the remote workstation; however, each instance will consume a network seat.

When using Remote Desktop Services or Citrix XenDesktop, you can only activate Trados
Studio with a network license. Each user session consumes one network seat until all
available seats are exhausted.

Network licensing when upgrading
from a previous version

Upgrading from Trados Studio 2014 SP2, 2015, 2017 or
2019

If you are a Trados Studio 2014 SP2, 2015, 2017 or 2019 user upgrading to Trados Studio
2022 SR2 in a network-licensing scenario, upgrade to the latest version of Trados License
Manager to activate the Trados Studio license.

Upgrading from Trados Studio 2011 and 2014 pre-SP2

If you are a Trados Studio 2011 or 2014 pre-SP2 user upgrading to Trados Studio 2022 SR2 in
a network-licensing scenario, install the new License Server Manager to activate the Trados
Studio license. You can continue to use Trados Studio 2011 or 2014 pre-SP2 with network
licensing using the legacy License Server Toolkit.
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9

Compatibility



This section lists the previous Trados Studio versions that Trados Studio 2022 SR2 is
compatible with. It also offers information on special compatibility with other important
software.

Upgrading to Trados Studio 2022 SR2
and MultiTerm 2022 SR2
To avoid any usage incompatibility between Trados Studio and MultiTerm, you must upgrade
both these products to their latest version.

About this task

Trados Studio 2022 SR2 features a number of language infrastructure updates that may
cause incompatibility challenges with some of the existing apps that work with language
metadata, such as NMT apps.

New versions of such apps are made available with this Trados Studio release to ensure a
smooth transition.

We recommend that you uninstall your apps before installing Trados Studio 2022 SR2, and
re-install them once Trados Studio 2022 SR2 is installed. Alternatively, go to Add-Ins > RWS
App Store right after installation and update all listed apps before starting to useTrados
Studio 2022 SR2.

Procedure

1. Exit Trados Studio and MultiTerm, and close any Microsoft Office applications.

2. Log in to your account .

3. Go to the Downloads section.

4. Expand the new Trados Studio 2022 SR2 /MultiTerm 2022 SR2 product name and you
will find the required downloads.

5. Select Download for each application and save the executable files to your local hard
disk.

6. Run both .exe files one at a time and follow the wizard-driven process.

Compatibility with previous Trados
Studio versions
Trados Studio 2022 SR2 can run alongside previous versions of Trados Studio.

However, as a service release for Trados Studio 2022, Trados Studio 2022 SR2 installs on top
of previous Trados Studio 2022 versions and cannot run alongside it.
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Compatibility with Trados Studio 2015, 2017, 2019 and
2021 versions

Trados Studio 2022 and Trados Studio 2015, 2017, 2019 and 2021 versions have the same
project and package format.

Plug-in for Trados Studio 2015

Trados Studio 2015 users can use TMs generated in Trados Studio 2017 SR1 CU15 and later,
if they first convert these TMs using the TM Compatibility Plug In.

1. Go to RWS AppStore and download the TM Compatibility Plug In for free.

2. Run the Plugin installer.

3. Open Trados Studio 2015.

4. Go to the Home tab, select Back Convert TM, browse for the TM and select Yes.

SDL Trados Studio 2015 users can also be prompted to back convert their TM at the end of
the Project Creation wizard or when they add the TM as a new resource to an existing
project.

Plug-in for Trados Studio 2022 SR2

You can also install Trados Studio 2022 SR2 alongside SDL Trados 2007, Trados Workbench
and SDLX.

To open and work with files created in these legacy versions, first install the Trados
Compatibility and Migration Power Pack app from the RWS AppStore. This free app adds
the infrastructure required to work with the following legacy files in Trados Studio 2021 and
later:

• S-tagger

• Bilingual Workbench

• *.TMW

• *.MDB

• *.ITD

• *.TTX

To install the app, go to the Add-Ins tab > RWS AppStore or visit https://appstore.rws.com .

Compatibility of older TMs with Trados Studio 2022
SR2

When using a TM from an earlier Trados Studio release with the latest Trados Studio release,
you will have no problem accessing its resources during translation. However, you will not
be able to benefit from the latest TM performance enhancements related to upLIFT fragment
matches, upLIFT MatchRepair, fuzzy matches and context matches.
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Tip: RWS recommends that you upgrade all your older or earlier TMs to the latest Trados
Studio release version by using one of the available Translation Memory Upgrade
mechanisms . All TMs which require an upgrade (either because they are older or they
require reindexing because their settings have changed) are flagged with an exclamation
mark.

Compatibility of cloud projects opened in Trados Studio 2021/2022 with older Studio
versions

Starting with the Trados Studio 2021/2022 release, you can create, download, and work with
cloud projects directly from Trados Studio. Cloud projects that you download locally in
Trados Studio 2021/2022 cannot be opened in previous versions of Trados Studio that might
be installed side-by-side with Trados Studio 2021/2022 on your machine. This is because
previous versions of Trados Studio use different mechanisms to open cloud projects and do
not support the latest refinements.

However, cloud projects are also compatible with Trados Studio 2019 and 2017. If you work
with Trados Studio 2019, you can download them using the Open in Studio button in the
browser user interface. It is also possible to download project packages from the browser.
These are compatible with Trados Studio 2022, 2021, 2019 and 2017.

Compatibility with other software

Passolo
Trados Studio 2022 SR2 is compatible with Passolo 2022 SR1 but not compatible with
Passolo 2018.

MultiTerm Desktop
You can use MultiTerm 2022, MultiTerm 2021 and MultiTerm 2019 and on the same
computer as Trados Studio 2022 SR2.

AppStore plugins
Trados Studio 2022 SR2 introduces several terminology capability updates that may result
in compatibility issues with certain existing apps, particularly those that use terminology
capabilities. Although new versions of these apps are not bundled with this Studio release,
many have been updated and are available through the integrated AppStore in Trados
Studio, or by download from the RWS AppStore.

To avoid potential issues, we advise you to uninstall all apps before installing Trados
Studio 2022 SR2, and then reinstall them once Studio SR2 is in place via the integrated
AppStore. Navigate to Add-Ins > RWS App Store and update all listed apps before you
begin using the new Studio version.

Please note that not all apps will have been updated yet for compatibility with Trados
Studio 2022 SR2 and it is possible an incompatible app could attempt to load into Studio.
Therefore, uninstalling all apps before installing SR2 can reduce, but not completely
eliminate, the risk of installing an incompatible app. If you encounter any problems, please
report them in the RWS Community using this link .
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GroupShare
Trados Studio 2022 SR2 is compatible with Trados GroupShare 2020 and 2017. Trados
recommends latest GroupShare 2020 update for optimum performance.

Trados Studio 2022 SR2 does not work with Trados GroupShare 2015 and below.

Trados cloud
Cloud projects are compatible with Trados Studio 2022, 2021, 2019 and 2017. In Trados
Studio 2022, you can create and work with cloud projects both from Trados Studio and
your cloud account. If you work with Trados Studio 2019 or earlier, you can download cloud
project packages from the browser and open them from Trados Studio using the Open
in Studio button in the browser user interface.

TMS
Trados Studio 2022 SR2 is compatible with all bilingual files and packages created in TMS
12.x.

TMS and Trados Studio extraction settings
Currently, TMS does not include an auto-update feature to immediately match the changes
that Trados Studio makes to its File Types via Cumulative Updates. This means that
sometimes you may find differences between file content extracted as translatable text in
Trados Studio and in TMS. To ensure full compatibility between Trados Studio and TMS,
RWS recommends that you use the version of Trados Studio that contains the same set of
File Types as your TMS. You can also manually configure the TMS Content Types settings
to synchronize the content extraction logic.

For more information on which version of Trados Studio is in line with TMS, contact RWS
Support or check the TMS release notes.

WorldServer
Starting with the 2021 release, Trados Studio has migrated support for WorldServer
projects to a dedicated app available in the RWS AppStore. To work with bilingual files
and packages, including Live TM connections, created in WorldServer 11.x and 10.4.5, go
to the Add-ins tab > RWS AppStore and install the freeWorldServer Compatibility Pack
for Studio.
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Supported releases



Trados Studio 2022 SR2 is the most recent fully supported release of Trados Studio.

RWS continues to support Trados Studio 2021 as the limited support release.

For Trados Studio 2021, RWS will issue service releases and cumulative updates as and
when required.

Retired releases

With the release of Trados Studio 2022 SR1, Trados Studio 2019 has been moved to an
End-of-Life state, along the following already retired versions: Trados Studio 2017, 2015,
2014, 2011 and 2009.
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Localization



The user interface and the documentation for Trados Studio 2022 are available in the
following languages:

• German

• French

• Spanish

• Japanese

• Simplified Chinese

• Italian (user interface only)

• Russian (user interface only)

• Korean (user interface only)
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Further information



This section lists the resources available for getting more help and information on Trados
Studio 2022 SR2.

Help
Trados Studio Help
The Help for Trados Studio 2022 SR2 is available by selecting Help tab > Help Topics in
Trados Studio. You can also go to the RWS Documentation Center to access the Trados
Studio Help. Here you can find links to:

• Information on installing and upgrading to Trados Studio 2022 SR2

• Videos and information on how to get started with Trados Studio

• Help topics about working with Trados Studio and Trados GroupShare projects.

Trados GroupShare Help
If you are working with Trados GroupShare projects, you may also find the Trados
GroupShare Help useful. Here you can find links to:

• Information on installing and upgrading Trados GroupShare

• Help topics describing how to work with Trados GroupShare

MultiTerm Help
For information on working with termbases, see the MultiTerm Help .

Customer support
To contact Technical Support, connect to the Customer Support Web Portal at
https://gateway.sdl.com and log a case for your RWS product. You need an account to log a
case. If you do not have an account, contact your company's RWS Support Account
Administrator.

Creating a Support and Maintenance contract

You need valid Support and Maintenance contract to log a support case. To see your Support
options go to your RWS Account:

Procedure

1. Go to www.rws.com .

2. Select Account login and log in with your email and password.

3. Select your profile name and then Support

4. Complete registration by filling in your details.

If you have any other issues regarding Trados Studio, go to the Trados forum on the
RWS Community .

12 Further information

56 Release Notes

https://docs.rws.com/TradosStudio
http://docs.rws.com/TradosGroupShare
http://docs.rws.com/TradosGroupShare
http://docs.rws.com/MultiTerm
https://gateway.sdl.com
http://www.rws.com/
https://community.rws.com/product-groups/trados-portfolio/trados-studio/


13

Acknowledgments



Trados Studio includes open source or similar third-party software.

ANTLR 3 Runtime
Version: 3.1.3

Vendor: Terence Parr

Copyright: Copyright (c) 2011 The ANTLR Project

License type: BSD

License details: https://github.com/antlr/antlrcs/blob/master/LICENSE.txt

Autofac
Version: 4.8.1

Vendor: Autofac

Copyright: Copyright © 2015 Autofac Contributors

License type: MIT

License details: https://github.com/autofac/Autofac/blob/v4.8.1/LICENSE

Azure.Core
Version: 1.24.0

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt

Azure.Identity
Version: 1.6.0

Vendor: Microsoft, azure-sdk

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt

CachedImage
Version: 0.1.9

Vendor: Hari Pachuveetil

Copyright: MIT © Haridas Pachuveetil 2014

License type: MIT

License details: https://github.com/floydpink/CachedImage/blob/main/LICENSE

CompactEncodingDetector
Version: 2.0.0

Vendor:

Copyright:
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License type:

License details:

ControlzEx
Version: 4.4.0

Vendor: Jan Karger, Bastian Schmidt

Copyright: Copyright © 2015 - 2020 Jan Karger, Bastian Schmidt, James Willock

License type: MIT

License details: https://github.com/ControlzEx/ControlzEx/blob/4.4.0/LICENSE

Crc32C.NET.signed
Version: 1.0.5

Vendor: Robert Važan

Copyright: Copyright (c) 2014-2020, Robert Važan

License type: BSD-3-Clause

License details: https://github.com/robertvazan/crc32c.net/blob/master/LICENSE

DocumentFormat.OpenXml
Version: 2.15.0

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/OfficeDev/Open-XML-SDK/blob/v2.15.0/LICENSE

Flee
Version: 1.2.2

Vendor: Muhammet Parlak

Copyright: Copyright 2017 Muhammet Parlak

License type: L-GPL

License details: https://github.com/mparlak/Flee

HtmlAgilityPack
Version: 1.11.16

Vendor: ZZZ Projects

Copyright: Copyright © ZZZ Projects Inc.

License type: MIT

License details: https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE

13Acknowledgments

59Release Notes

https://github.com/ControlzEx/ControlzEx/blob/4.4.0/LICENSE
https://github.com/robertvazan/crc32c.net/blob/master/LICENSE
https://github.com/OfficeDev/Open-XML-SDK/blob/v2.15.0/LICENSE
https://github.com/mparlak/Flee
https://github.com/zzzprojects/html-agility-pack/blob/v1.11.16/LICENSE


Hunspellx86
Version: 1.7.2

Vendor: Crawler-Lib

Copyright: Copyright (C) 2002-2017 Németh László

License type: L-GPL

License details: https://github.com/hunspell/hunspell/blob/v1.7.2/license.hunspell

ICSharpCode.Decompiler
Version: 7.1.0.6543

Vendor: Daniel Grunwald, Siegfried Pammer

Copyright: Copyright 2011-2021 AlphaSierraPapa

License type:

License details: https://github.com/icsharpcode/ILSpy/blob/v7.1/doc/license.txt

icu.net
Version: 2.9.0

Vendor: SIL International

Copyright: Copyright © 2007-2019 SIL International

License type: MIT

License details: https://github.com/sillsdev/icu-dotnet/blob/v2.9.0/LICENSE

Icu4c.Win.Full.Lib
Version: 59.1.15

Vendor: SIL International

Copyright: Copyright (c) 2016-2017 SIL International

License type: ICU

License details: https://github.com/unicode-org/icu/blob/release-59-1/icu4c/LICENSE

Interop.SHDocVw.dll
Version: 1.0.0

Vendor:

Copyright:

License type:

License details:

log4net
Version: 2.0.14

Vendor: Cincura.net, Apache.Logging

Copyright: Copyright 2004-2017 The Apache Software Foundation

License type: Apache 2.0
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License details: https://github.com/apache/logging-log4net/blob/rel/2.0.14/LICENSE

MahApps.Metro
Version: 2.4.9

Vendor: Jan Karger, Dennis Daume

Copyright: Copyright © 2021 .NET Foundation and Contributors. All rights reserved.

License type: MIT

License details: https://github.com/MahApps/MahApps.Metro/blob/2.4.9/LICENSE

Markdig.Signed
Version: 0.30.4

Vendor: Alexandre Mutel

Copyright: Copyright (c) 2018-2019, Alexandre Mutel

License type: BSD-2-Clause

License details: https://github.com/xoofx/markdig/blob/0.30.4/license.txt

MaterialDesignColors
Version: 2.0.4

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE

MaterialDesignThemes
Version: 4.3.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE

MaterialDesignThemes.MahApps
Version: 0.2.0

Vendor: James Willock

Copyright: Copyright 2015 James Willock/Mulholland Software Ltd

License type: MIT

License details:
https://github.com/MaterialDesignInXAML/MaterialDesignInXamlToolkit/blob/v4.3.0/LICENSE
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https://github.com/MahApps/MahApps.Metro/blob/2.4.9/LICENSE
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Microsoft.ApplicationInsights
Version: 2.20.0

Vendor: Microsoft, AppInsightsSdk

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.20.
0/LICENSE

Microsoft.AspNetCore.Connections.Abstractions
Version: 6.0.2

Vendor: Microsoft, aspnetcore

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt

Microsoft.AspNetCore.Http.Connections.Client
Version: 6.0.2

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt

Microsoft.AspNetCore.Http.Connections.Common
Version: 6.0.2

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt

Microsoft.AspNetCore.JsonPatch
Version: 7.0.1

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/aspnetcore/blob/v7.0.1/LICENSE.txt

Microsoft.AspNetCore.SignalR.Client
Version: 6.0.2

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.
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https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.20.0/LICENSE
https://github.com/microsoft/ApplicationInsights-dotnet/blob/2.20.0/LICENSE
https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt
https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt
https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt
https://github.com/dotnet/aspnetcore/blob/v7.0.1/LICENSE.txt


License type: MIT

License details: https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt

Microsoft.Bcl.AsyncInterfaces
Version: 7.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v7.0.0/LICENSE.TXT

Microsoft.Bcl.HashCode
Version: 1.1.1.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/main/LICENSE.TXT

Microsoft.Data.SqlClient
Version: 5.0.0.0

Vendor: Microsoft, nugetsqltools

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/SqlClient/blob/v5.0.0/LICENSE

Microsoft.Data.SqlClient.SNI.runtime
Version: 5.0.0.0

Vendor: Microsoft, nugetsqltools

Copyright: © Microsoft Corporation. All rights reserved.

License type: MSEULA, MSL

License details: https://www.nuget.org/packages/Microsoft.Data.SqlClient.SNI.runtime/5.
0.0/License

Microsoft.Extensions.DependencyInjection
Version: 6.0.1

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.1/LICENSE.TXT
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https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt
https://github.com/dotnet/runtime/blob/v7.0.0/LICENSE.TXT
https://github.com/dotnet/runtime/blob/main/LICENSE.TXT
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https://www.nuget.org/packages/Microsoft.Data.SqlClient.SNI.runtime/5.0.0/License
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https://github.com/dotnet/runtime/blob/v6.0.1/LICENSE.TXT


Microsoft.Extensions.DependencyInjection.Abstractions
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

Microsoft.Extensions.DependencyModel
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/core/blob/v6.0.0/LICENSE.TXT

Microsoft.Extensions.Features
Version: 6.0.2

Vendor: Microsoft, aspnet

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt

Microsoft.Extensions.Http
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

Microsoft.Extensions.Logging
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

Microsoft.Extensions.Logging.Abstractions
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT
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https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT
https://github.com/dotnet/core/blob/v6.0.0/LICENSE.TXT
https://github.com/dotnet/aspnetcore/blob/v6.0.2/LICENSE.txt
https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT
https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT


License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

Microsoft.Extensions.Options
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

Microsoft.Extensions.Primitives
Version: 6.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

Microsoft.Identity.Client
Version: 4.46.0

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/microsoft-authentication-library-for
-dotnet/blob/4.46.0/LICENSE

Microsoft.Identity.Client.Extensions.Msal
Version: 2.19.3

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/microsoft-authentication-extensions-for
-dotnet/blob/2.19.1/LICENSE

Microsoft.IdentityModel.JsonWebTokens
Version: 6.25.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.25.1/LICENSE.txt
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https://github.com/AzureAD/microsoft-authentication-library-for-dotnet/blob/4.46.0/LICENSE
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https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/6.25.1/LICENSE.txt


Microsoft.IdentityModel.Logging
Version: 6.25.1

Vendor: Microsoft, AzureAD

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.25.1/LICENSE.txt

Microsoft.IdentityModel.Protocols
Version: 6.21.0

Vendor: Microsoft, AzureAD

Copyright: Copyright (c) Microsoft Corporation

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.21.0/LICENSE.txt

Microsoft.IdentityModel.Tokens
Version: 6.25.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.25.1/LICENSE.txt

Microsoft.Office.Interop.Outlook
Version: 15.0.4797.1003

Vendor: Camron Bute

Copyright:

License type:

License details:

Microsoft.Office.Interop.Word
Version: 15.0.4797.1003

Vendor: Camron Bute

Copyright:

License type:

License details:
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https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/6.25.1/LICENSE.txt
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https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/6.21.0/LICENSE.txt
https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/6.21.0/LICENSE.txt
https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/6.25.1/LICENSE.txt
https://github.com/AzureAD/azure-activedirectory-identitymodel-extensions-for-dotnet/blob/6.25.1/LICENSE.txt


Microsoft.Web.WebView2
Version: 1.0.1774.30

Vendor: Microsoft, webview

Copyright: ©Microsoft Corporation. All rights reserved.

License type:

License details: https://www.nuget.org/packages/Microsoft.Web.WebView2/1.0.1774.
30/License

Microsoft.Win32.Registry
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

Microsoft.WindowsAPICodePack
Version: 7.0.4

Vendor: pwagner

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: NuGet Gallery | License of WindowsAPICodePack 7.0.4

Microsoft.Xaml.Behaviors.Wpf
Version: 1.1.39

Vendor: Microsoft, xamlexperiencesteam

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/microsoft/XamlBehaviorsWpf/blob/master/LICENSE

murmurhash-signed
Version: 1.0.2

Vendor: Darren Kopp

Copyright: Copyright 2013 Darren Kopp

License type: Apache 2.0

License details: https://github.com/darrenkopp/murmurhash
-net/blob/master/LICENSE.md

NETStandard.Library
Version: 2.0.3.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.
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https://www.nuget.org/packages/Microsoft.Web.WebView2/1.0.1774.30/License
https://www.nuget.org/packages/Microsoft.Web.WebView2/1.0.1774.30/License
https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT
NuGet%20Gallery%20%7C%20License%20of%20WindowsAPICodePack%207.0.4
https://github.com/microsoft/XamlBehaviorsWpf/blob/master/LICENSE
https://github.com/darrenkopp/murmurhash-net/blob/master/LICENSE.md
https://github.com/darrenkopp/murmurhash-net/blob/master/LICENSE.md


License type: MIT

License details: https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT

Newtonsoft.Json
Version: 13.0.2

Vendor: James Newton-King

Copyright: Copyright © James Newton-King 2008

License type: MIT

License details: https://github.com/JamesNK/Newtonsoft.Json/blob/13.0.2/LICENSE.md

NLog
Version: 4.6.7

Vendor: Jarek Kowalski, Kim Christensen, Julian Verdurmen

Copyright: Copyright (c) 2004-2020 NLog Project - https://nlog-project.org/

License type: BSD-3-Clause

License details: https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt

Npgsql
Version: 6.0.7

Vendor: Shay Rojansky,Yoh Deadfall,Austin Drenski,Emil Lenngren,Francisco Figueiredo
Jr.,Kenji Uno

Copyright: Copyright 2019 © The Npgsql Development Team

License type: POSTGRESQL

License details: https://github.com/npgsql/npgsql/blob/v6.0.7/LICENSE

Nquant
Version: 1.0.3

Vendor: Matt Wrock

Copyright: Copyright Matt Wrock 2011

License type: Apache 2.0

License details: https://github.com/philjones/nquant/blob/master/License.txt

PowerCollections
Version: 1.0.0.0

Vendor: Wintellect

Copyright: Copyright 2015 Wintellect

License type: EPL

License details: https://www.nuget.org/packages/Stakata.Wintellect.PowerCollections/1.0.
4/License
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https://github.com/dotnet/standard/blob/v2.0.3/LICENSE.TXT
https://github.com/JamesNK/Newtonsoft.Json/blob/13.0.2/LICENSE.md
https://github.com/NLog/NLog/blob/v4.6.7/LICENSE.txt
https://github.com/npgsql/npgsql/blob/v6.0.7/LICENSE
https://github.com/philjones/nquant/blob/master/License.txt
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https://www.nuget.org/packages/Stakata.Wintellect.PowerCollections/1.0.4/License


Sdl.MultiSelectComboBox
Version: 1.0.42

Vendor: RWS

Copyright: Copyright © RWS

License type: Apache 2.0

License details: https://github.com/RWS/Multiselect-ComboBox/blob/master/LICENSE

SharpCompress
Version: 0.32.2

Vendor: Adam Hathcock

Copyright: Adam Hathcock

License type: MIT

License details: https://github.com/adamhathcock/sharpcompress/blob/0.32.
2/LICENSE.txt

SharpZipLib
Version: 1.4.1.0

Vendor: ICSharpCode

Copyright: Copyright © 2000-2018 SharpZipLib Contributors

License type: MIT

License details: https://github.com/icsharpcode/SharpZipLib/blob/v1.4.1/LICENSE.txt

SimpleInjector
Version: 5.3.3

Vendor: Simple Injector Contributors

Copyright: Simple Injector Contributors 2010 - 2020

License type: MIT

License details: https://github.com/simpleinjector/SimpleInjector/blob/v5.3.3/LICENSE

SmartThreadPool
Version: 2.3.0

Vendor: Ami Bar

Copyright: Copyright © Ami Bar

License type: MS-PL

License details: https://github.com/amibar/SmartThreadPool/blob/v2.3.0/LICENSE

System.Buffers
Version: 4.5.1

Vendor: Microsoft

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Collections.Immutable
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.ComponentModel.Annotations
Version: 4.5.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

System.Configuration.ConfigurationManager
Version: 6.0.1

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.1/LICENSE.TXT

System.Data.SQLite
Version: 1.0.111

Vendor: SQLite

Copyright: Public domain

License type: Public domain

License details: https://www.sqlite.org/copyright.html

System.Diagnostics.DiagnosticSource
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT
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https://github.com/dotnet/corefx/blob/master/LICENSE.TXT
https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT
https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT
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https://www.sqlite.org/copyright.html
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System.Drawing.Common
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.Formats.Asn1
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.IdentityModel.Tokens.Jwt
Version: 6.25.1

Vendor: Microsoft, AzureAD

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/AzureAD/azure-activedirectory-identitymodel
-extensions-for-dotnet/blob/6.25.1/LICENSE.txt

System.IO.Abstractions
Version: 8.0.3

Vendor: Tatham Oddie

Copyright: Copyright © Tatham Oddie 2010

License type: MIT

License details: https://github.com/TestableIO/System.IO.Abstractions/blob/v8.0.
3/LICENSE

System.IO.FileSystem.AccessControl
Version: 4.7.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/main/LICENSE.TXT

System.IO.Pipelines
Version: 6.0.2

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.
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https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT
https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT
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License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.2/LICENSE.TXT

System.Management
Version: 6.0.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.Memory
Version: 4.5.5.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Memory.Data
Version: 1.0.2.0

Vendor: Microsoft, azure-sdk, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/Azure/azure-sdk-for-net/blob/main/LICENSE.txt

System.Numerics.Vectors.dll
Version: 4.5.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Reactive
Version: 5.0.0

Vendor: rxteam, dotnetfoundation

Copyright: Copyright (c) .NET Foundation and Contributors.

License type: MIT

License details: https://github.com/dotnet/reactive/blob/rxnet-v5.0.0/LICENSE
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System.Reflection.Metadata
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

System.Reflection.TypeExtensions
Version: 4.7.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Runtime.CompilerServices.Unsafe
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.Security.AccessControl
Version: 6.0.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Security.Cryptography.Algorithms
Version: 4.3.1

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Security.Cryptography.Cng
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT
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License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

System.Security.Cryptography.OpenSsl
Version: 4.3.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type:

License details: https://dotnet.microsoft.com/en-us/dotnet_library_license.htm

System.Security.Cryptography.ProtectedData
Version: 6.0.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Security.Cryptography.X509Certificates
Version: 4.3.2

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.Security.Permissions
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/main/LICENSE.TXT

System.Security.Principal.Windows
Version: 5.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v5.0.0/LICENSE.TXT

System.Text.Encoding.CodePages
Version: 6.0.0.0

Vendor: Microsoft, aspnet, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.
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License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.Text.Encodings.Web
Version: 7.0.0

Vendor: Microsoft, dotnetframework

Copyright: ©Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v7.0.0/LICENSE.TXT

System.Text.Json
Version: 7.0.1

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v7.0.1/LICENSE.TXT

System.Threading.Channels
Version: 6.0.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/runtime/blob/v6.0.0/LICENSE.TXT

System.Threading.Tasks.Extensions.dll
Version: 4.5.4

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT

System.ValueTuple.dll
Version: 4.5.0

Vendor: Microsoft, dotnetframework

Copyright: © Microsoft Corporation. All rights reserved.

License type: MIT

License details: https://github.com/dotnet/corefx/blob/master/LICENSE.TXT
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Xerces
Version: 2.1.0

Vendor: Kikuchi

Copyright: Copyright © 1999-2016 The Apache Software Foundation.

License type: Apache 2.0

License details: https://xerces.apache.org/legal.html

Xliff.OM (Sdl.Xliff.OM)
Version: 1.2.3.0

Vendor: RyanKi

Copyright: Copyright 2016 RyanKi

License type: MIT

License details: https://github.com/microsoft/XLIFF2-Object
-Model/blob/master/LICENSE.txt

YamlDotNet
Version: 8.1.0

Vendor: Antoine Aubry

Copyright: Copyright (c) Antoine Aubry and contributors 2008 - 2019

License type: MIT

License details: https://github.com/aaubry/YamlDotNet/blob/v8.1.0/LICENSE.txt
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